Welcome From The Chief Editor
WOW! 60 issues. That translates into five years since I signed on as the Chief Editor of The PCLinuxOS Magazine. Throw into that mix eight special editions. When I originally agreed to be the magazine's editor, the original plans were to only do the job for a year or so, then turn it over to someone else. And here it is, five years later!
During that time, we've resurrected the magazine and put it back on a monthly publishing schedule. Other nay-sayers said there wasn't enough information to write about for a monthly publication schedule. Really? With nearly 14,000 packages in the repos, I think in the past five years we've just barely scratched the surface. Plus, the Linux landscape, and PCLinuxOS specifically, is always in a continual state of flux. Things change. Things evolve. There are updates all the time. Some of our favorite programs disappear, only to be replaced with newer ones. There are additions all the time. We've also introduced new, recurrent monthly columns, like Meemaw's monthly graphics tutorials, ms_meme's Nook, georgetoon's Double Take & Gimp Tip, ms_meme's Forum Foibles, and more multipart article series than you can shake a stick at. Yes, I think we've proven that there is plenty to write about to keep the magazine on a monthly publication schedule.
Oh ... and the magazine's death reports slightly more than five years ago ... they were WAY over exaggerated.

Indeed, it has been a fun (and arduous) past five years. Sure, we've had our ups and our downs. Some months, the content for the magazine practically writes itself. Other months, it is a struggle to come up with the content. Sometimes, the latter happens because of "writer's block." Other times, it's because "life" gets in the way and it's difficult to find time to sit down and write the articles. Some of the articles I initially thought would be the hardest to write ended up being the easiest to write. On the other side of that coin, some of the articles I thought would be the easiest to write ended up being some of the more difficult articles to write. I'd also like to thank all of those who have helped with the magazine over the past five years.
This month's cover image, designed by Meemaw, celebrates the bountiful fun that can found all across the U.S. at county fairs. July is the time of year in the U.S. when county fairs are in full swing, providing a lot of family fun.
Until next month, I bid you peace, happiness, serenity and prosperity.
PCLinuxOS Recipe Corner

Aussie Works Burger
Ingredients:
1 lb ground beef
1 large onion, sliced
4 eggs
4 slices Canadian bacon
4 pineapple rings
4 slices cheddar cheese
1 (8 1/4 ounce) can sliced beets, drained
4 slices Tomatoes
4 lettuce leaves
ketchup (optional)
dill pickle relish (optional)
mayonnaise (optional)
mustard (optional)
4 kaiser rolls, split and toasted
Directions:
1. Preheat an outdoor grill for high heat.
2. When the grill is ready, lightly oil the grilling surface. Form the ground beef into four patties, and grill for 5 minutes per side, or until cooked through.
3. Meanwhile, melt butter in a large skillet over medium heat. Add onions, and fry until soft. Remove the onions from the skillet, and crack the eggs in the same skillet over medium heat. Cook until the yolks are solid, turning over once. Remove the eggs, and set aside. Place the Canadian bacon in the same skillet, and fry until toasted. Remove the bacon, and turn the heat to high. Quickly fry the pineapple rings in the bacon drippings just until browned on each side.
4. To assemble sandwiches: Set bottom of Kaiser rolls on a plate, and top with burger, a slice of cheese, a slice of Canadian bacon, one fried egg, fried onions, a few slices of beet, a slice of pineapple, a slice of tomato, and a leaf of lettuce. Decorate the top bun with ketchup, mustard, relish and mayonnaise as desired. Place over the burger. Repeat with remaining burgers.

KDenLive, Part Six
by loudog
Hello friends, and welcome to another segment in our KDenLive series. In this article we will cover an interesting effect called Rotoscoping, as I finally found my camera tripod. There are countless things that you can do with this effect after you get the hang of it. We will also be going a little deeper in depth on the audio gain, "keyframable" effect. In my first video clip, I have some undesirable background sound I need to turn down. I also have some spoken words towards the end I need to turn up. So, why don't we dive right into the sound issue first and fix it. The first thing I will need to do is select the audio portion of the clip. Right click on it.

The effect will show up in the effect stack window. Notice the little clock in the top left side.

We want to click on that, which will bring up the keyframe options that you should be familiar with by this point, although they are a little different in this effect. You will see this:

Let's go over this effect bit by bit and discover how it works. The gain at the beginning of the clip is 100% (I have this clip cut at address 10:23, so that is my beginning) and the end of the clip (1:11:17) is at 100%. Let's change the beginning gain. In my case, I want to turn the gain (volume) down. I will select the beginning keyframe readout and move the gain slider until it reads 15, turning it way down.

You can see the gain is at 15 for the beginning of the clip. Now we want to determine where we want the volume turned back up. To do this, I generally look at the audio track and estimate the position by utilizing the audio signature.

The cursor clearly points out that nasty background noise we are editing. Also notice the timeline marker is where we want to turn the gain back up. Time to add a keyframe. Go to the green + and add one. With this keyframe we also want the gain to be at 15%. If we put it to 100 the volume would gradually increase from 15 to 100 between the two keyframes. You should understand this concept concerning keyframes at this point from our previous lessons. Now, very close to that keyframe we will add another with the gain at 100%. This essentially turns the volume back up to normal. The effect stack will look like this:

Between 41:05 and 56:11 the volume will increase from 15% to 100%. Review the clip to make sure the sound is as you like it. If it isn't, don't worry. With this effect you do not need to delete the keyframes and redo them, just grab them with the cursor and adjust up or down and forward or back in the audio track as necessary, the effect stack will auto update. Look at this image and you will understand a little better.

Now I need to increase the spoken words towards the end of the clip, because the microphone did not pick them up well. Moving the project timeline marker, I will navigate to the area where I need the gain increase. I will add a keyframe here at 100% and another one very close to that one at 170%. At the end of the spoken dialogue I will add another keyframe at 170%. Quickly after this keyframe, I will add the last one, turning the gain back down to 100%. My completed effect stack looks like this:

And the audio track shows the keyframe markers as thus:

Now you know how to manipulate the audio gain in your videos if the occasion arises. Now let's have a look at rotoscoping and do a simple clone. It is important to understand that the use of a camera tripod is a must for this to work properly. The camera angle, zoom and lighting must also be kept very close to the the same. Any panning or zooming should be done after the clone video is rendered for best results. First, we want 2 clips of the person or thing we are wanting to clone in the project timeline and aligned. On the top clip, add the composite transition and stretch it out to the full length of the videos, as we learned in previous articles. Next add the rotoscope effect to the top video clip also.

When the rotoscope effect appears in the effect stack, click the invert box. Ignore the other options for now because we will cover them in the future. Now, for the real fun. In the preview window, reduce the image a little with the slider at the right side for ease in mapping out the cut area. Unlike the old time movie effects you do not need to select a straight line for good results; the digital world lets you select any area you wish. For this simple clone, my cut area will be just a rectangle on one side of the video. Just click the borders of the cut zone you want and connect the dots to finish the borders. It will look like this:

Play the video and see how things are looking. Now, unclick the invert box and review again. Now you're getting it. I will leave you with this final screenshot of me saying to me "I know you from somewhere" to ponder while we wait for next month's magazine where I will cover this effect in more detail and give a link to the final product. Until then, it's summertime. Go swimming with Tux -- he loves it.



ms_meme's Nook: Boogie Woogie Tex
Improve Battery Life On Your Android Device
by Paul Arnote (parnote)
Ok, Ok. I know this is a bit of a departure from the kind of stuff that we normally run in The PCLinuxOS Magazine. But I also think it's something that a LOT of PCLinuxOS users are concerned about.
Unless you've just been rescued from a deserted island or you've spent the past five years living underground or under a rock, it's no secret that tablets and smartphones have exploded in the marketplace. In fact, tablets and smartphones now sell more total units than new PCs. I'm betting that many PCLinuxOS users have at least one (tablet or smartphone), if not both. They are convenient. They allow us to increase our access to all sorts of data, even when we are "on the go."

Of all the tablets and smartphones sold, Android devices have the greatest market share. Android devices have become exponentially prolific in the marketplace. Its appeal among Linux users is easily understandable: it runs on the Linux kernel. Now we're not going to even enter the pros and cons of Google, who "markets" the freely available Android OS. That is a whole other discussion and debate. Despite the fact that PCLinuxOS does not YET have a kernel built that will run on ARM devices, Android devices seem to be popular with users of PCLinuxOS.
But the fact of the matter is that many (if not most) of the Android devices available come with some pretty anemic batteries. It's not uncommon to find, for example, an Android based smartphone that comes with a 1500mAh battery. Let's look at an average eight hour work day. You usually start out in the morning with a battery that has a 100% charge. Despite plugging it in while at your desk (which may not always be possible or convenient), it's not uncommon to find the wimpy battery nearly depleted by the end of the work day. If you work longer -- say 10 or 12 hour shifts -- it's pretty much a foregone conclusion that the puny battery will be long gone before you get off work.
So, what can you do? Is there anything you can do? Fortunately, the answer to the second question is a resounding YES. Because of the wide selection of tablets and smartphones in the marketplace, not every device will have all of the options we discuss, so your milage may vary. But every little of battery power saved certainly helps. What follows are some things you can do to help milk more life from the paltry battery in your Android device. The images are from my LG G2 smartphone. The location of similar settings may differ on your device.
Buy A Larger Capacity Battery
This one won't work for everyone. There are tablets and smartphones out there that lack a user replaceable battery. I'm on my second smartphone without a user changeable battery (first it was the Droid Razr Maxx, and now it's the LG G2). However, popular smartphones, like the Samsung S series phones, do have user replaceable batteries. Even a blind man can see that there is a market for longer lasting batteries, and entrepreneurial folks have seen that need -- and have answered the call.
Let's pick on the Samsung S3, which came out last summer. It comes with a 2100mAh battery, which is more than the 1500mAh batteries I've seen in other smartphones, but is rather smallish for the needs of the S3. I've watched my coworkers fight a never-ending battle with the battery life on their Samsung S3s. Most days, it won't even hold the charge longer than six to eight hours. I work in a hospital, and our department's office is deep in the core of the hospital. As such, cell signals are very weak after passing through multiple concrete walls. Weak signals don't do much to help cell phone battery life, "we" (my coworkers and I) have found out.
Just a quick look on Amazon.com and I found many "extended" batteries. They all require (and come with) a replacement back plate for the phone. One example is the ZeroLemon 7000mAh extended battery, which comes with a rugged case to protect your S3 from hard drops and heavy shocks. Of course, because the battery is thicker than the OEM battery, it will transform your thin Samsung S3 into this:


It's definitely not an unwieldy size, but it isn't the slim, trim phone it once was, either. Like with all things, there is a trade off.
Of course, you could just make your next smartphone purchase with one of the primary considerations being the battery life. My Motorola Droid Razr Maxx had a 3500mAh battery, and my new LG G2 has a 3000mAh battery. Both seem to last for more than a day on a single charge, with average use (well, average for me ... I don't spend hours a day browsing Facebook, Google+, or playing games). When I was looking for a new cell phone, battery life was one of the items with a higher priority.
Dim Your Screen
One thing you can do to save some battery time is to dim your screen. Do you REALLY need it to be at (or near) full brightness? On my LG G2, I have the screen brightness set to 30%, and I can still see and operate the phone quite nicely.

You can also change the "Screen timeout" duration to something shorter, like 15 or 20 seconds. That means that after 15 or 20 seconds of inactivity, the screen blanks out. You can also turn off the "Screen-off Effect" to save even more battery life.
Turn Off Unnecessary Services
Virtually any cell phone made in the past five years has a setting that's known as "airplane mode." With airplane mode, all unnecessary radio transmissions and receptions (such as WiFi, Bluetooth, NFC, etc.) are turned off, and any sounds it might make are muted. Airplane mode will save a LOT of battery charge, and is certainly an option when you need your cell phone to remain on, but without all the extra radio signals it understands and uses.

Sometimes though, you can get away with something a lot less drastic. If you're in a location without WiFi access -- or if you have no intentions of connecting to the available WiFi signal -- turning off WiFi will save a significant amount of battery charge. Similarly, if you have no plans or intentions to use Bluetooth or Mobile Data, turning them off will also save some battery charge. While NFC (Near Field Communication) is nice to have, its use is anything but routine for many users. The same thing applies to the various "beaming" protocols that many manufacturers have created to make it easier to share content with others using the same manufacturers equipment.
Turn Off Tethering & Mobile Hotspots
Being able to tether your computer to your smartphone or tablet makes it easy to use your computer while you're "on the go." Similarly, using your device's 3G or 4G connection to create a WiFi hotspot produces much the same capabilities. I've done the latter several times, even riding down the interstate highway (as the passenger, mind you), while connected to the internet via the mobile hotspot app on my phone.

If you have no plan or need to use these services, turning them off may save you some battery juice for more vital functions.
Stop Unnecessary Applications
On virtually every Android device I've ever seen or used, there is usually a function called "Manage Applications" or "Application Manager." This function allows you to see all the apps that you've downloaded, all the apps that are running, and every app installed on your device.


From there, you can either uninstall unwanted apps, or "Force Stop" applications that are running that you aren't planning on using. The fewer apps that are running, the longer your battery will last. After all, fewer running apps mean fewer CPU cycles being consumed and more freed memory that doesn't have to be continually maintained and updated. As a result, your battery will last longer.
Turn On Power Savings Setting


On your Android device, you may have a separate entry, named something like "Power Management" or "Power Savings." On my LG G2, the Battery Savings setting is under the Battery setting. Wherever it may be located, and whatever it may be called, this one can certainly extend the life of your battery. The images above represent the default (out of the box) settings for my LG G2, since I have not yet tweaked those settings.
Typically, you can set it to automatically turn off things like WiFi and Bluetooth when they are not in use. Other things that can save excessive battery drain, like the vibratory touch feedback and the screen brightness, are set to help save battery life. Even the screen lock timeout is reset (on my smartphone) from a generous 60 seconds to only 15 seconds. When the battery gets down to a specified level that you set (10%, 20%, 30%, or 50%), the battery saver functions turn on. There is even a setting to allow you to turn them on immediately.
Of course, if you choose the latter setting of turning them on immediately, you will have to go in and manually activate Wi-Fi or Bluetooth connectivity before you can use those services. If you are especially frustrated by a lack of battery time on your Android device, manually activating these services before they can be used may not be a bad thing, since it basically keeps them turned off until they are manually activated. This could turn a device with a particularly anemic battery into one that serves its intended purpose for a much greater amount of time. It's something to seriously consider.
Checking Your Accounts
Do you really need a notification every single time an email lands in your Inbox? Most of the time, that answer is no. Some Android devices allow you to specify how often your accounts are checked for new content. On many devices, the account checking frequency is set to "push." This means as soon as new content is posted to one of your accounts, you're immediately notified. You can often change this to only checking every 10 minutes, 15 minutes, hour, two hours, etc. For most of us, most of the time, one of these less frequent account checking schedules is sufficient. You'll expend a lot less battery capacity if you set this to less frequent checking.
Clean Up!
Just like with any computer, your smartphone and tablets will accumulate junk. Apps will be left running in the background. Trash files will be left behind from previous sessions, consuming valuable storage. All of these have the potential to wreak havoc on your device's battery.
It can be quite a task trying to navigate through all of the confusing menus of the Android OS. Even the most die hard, seasoned Android user will miss a setting -- or two, or three, or more. When you need to preserve battery life, especially on the plethora of underpowered devices out there, there's little else that can match the usefulness of a specialty app that puts all of those settings into one convenient user interface.

One free app is called Clean Master. This app allows you to clean junk files from your device. It also allows you to regain the storage space on your device that was formerly occupied by those junk files. Of the millions of apps out there now, many of them create residual files that are left littering up your limited storage space when they are finished running. Many of them create cache files that also consume valuable storage space. Clean Master keeps track of those residual files created by the myriad of apps so that it can zero in on -- and delete -- those files.
It will also help uninstall unwanted apps and bloatware, as well as back up important apps. If you've rooted your device, you will be able to move apps to the SD card of your device, as well as uninstall pre-installed and system apps.
Clean Master also contains an antivirus module to scan the system, pre-installed apps and user downloaded apps to help keep the device safe from viruses, trojans, vulnerabilities, adware and spyware. It will also help to remove personal and sensitive information from your device to protect your privacy.
Install A Battery Saver App
If navigating your Android device's menus is confusing (and yes, often times they are), then it might be handy to have an app that manages many of the things we already talked about -- such as turning off mobile data, WiFi, Bluetooth, etc. whenever they are not in use -- automatically.


Meet JuiceDefender. With it, you can manage the connectivity options of your device. Besides coming with some preconfigured profiles (Balanced, Aggressive and Extreme), you can customize the settings as much as you wish. JuiceDefender also allows you to configure a specified interval of time to turn the "tuned out" radio signals to perform updates (email, Twitter, etc.) periodically, and then shut those signals down again until the next interval. It also comes with a screen widget that allows you immediate access to JuiceDefender from one of your device screens.
Sure, you will consume some battery life by running an app, such as JuiceDefender. But you will not come close to using the amount of battery power that is required to continuously power all the various radio signals that your device uses to provide your connectivity.
Fewer Clouds, Sunnier Day
Certainly, a lot of people use cloud based storage apps. It's handy to have them all stored in, say Dropbox, and then access them when needed from any of your connected devices. But it comes at a price. The price that's most often paid is in battery life. Every time you access cloud storage to retrieve a file, you consume vastly more battery life than if you stored that file on your device and simply launched it with an app that can read that file. So, if you have certain files that you access repeatedly, consider storing those files on your device's storage.
Disable Motion Detection
Some devices link certain movements to special functions. For example, some of the more recent smartphones will automatically answer a call when they detect a certain movement, and others will take pictures when another certain movement is detected. If you're plagued by a battery that doesn't meet your needs, you may want to disable all this extra motion detection, and stick only with your screen changing from portrait to landscape. If you're critically short of battery power, you might even want to disable this function.
Cool It With Multimedia
While it's cool and all to play an endless stream of YouTube videos, or even movies, on your mobile device, it will eat up battery life quicker than just about anything else. Playback of videos is quite CPU intensive, regardless of what platform you are using. Anything that causes your device to consume more CPU cycles is going to drain your battery proportionally. Music playback doesn't consume battery life at nearly the same rate, but it will shorten your battery life more than if you hadn't listened to your favorite MP3s (consider using a standalone MP3 player, like the Sansa Clip +). Streaming music will consume more battery life than if you playback static music files stored on your device. You're not only just playing back the music, but you're also downloading it as you go. Thus, you are playing back music AND downloading music over a radio signal.
Summary
The problem with the batteries in Android devices is three-fold. First, battery technology is evolving on how to pack more and more power into smaller and smaller packages. Of course, that technology comes at a price, and manufacturers, ever seeking to increase profits (or maintaining current profit margins), don't necessarily put the latest and greatest batteries in their devices.
Second, the large number of manufacturers offering Android devices -- many that you have never heard of -- indicate just how many fly-by-night manufacturers are out there hawking devices where lots of corners have been cut. Of course, one popular corner to cut is to use either really anemic batteries or batteries with older battery technology in their devices. Third, the "cheaper" devices are sold at less expensive prices because they may be using older technology, such as older CPUs that aren't as efficient and that don't conserve power as well as more modern CPUs. Other components of the device may also not be the "greenest" available, and they may also contribute towards a shorter battery life.
Whatever you case might be, I hope these 12 tips help you tame your device so that it is more frugal with the limited amount of battery power that you have available. Of course, to keep your device as available to you and your needs as possible, it might still be a great idea to keep it plugged into a more reliable power source as much as possible.


Inkscape Tutorial: Reinvent The Wheel
by Khadis

An alternative of graphic design software, Inkscape is quite powerful, like CorelDraw, including the ability to make a vector based graphics illustration. Several years ago, when I studied graphic design, I made a wheel illustration using CorelDraw as one of my 'basic' exercises. Now, I will make the same wheel using Inkscape.
1. Open up Inkscape. Create a circle with the ellipse tool. The size absolutely depends on your taste, while the fill color is white and the stroke color is black, with any thickness you desire.

2. Ensure that the snap option is active (can be accessed under View menu). Please also activate "snap from and to center of objects" option as illustrated below:

3. After that, create a rectangle (fill color: black, stroke color: black or no stroke is also OK). Convert it into a path. This rectangle will be transformed into a trapezoid. Select this rectangle and choose Path - Object to Path menu (Shift + Ctrl + C). You can use the "edit path by node" tool (F2) to modify this rectangle into a trapezoid by dragging in the handles in the top right and top left corner.
4. Place this trapezoid above the circle. For a clear view, take a look at the picture below:

5. After that, activate the Transform panel (Shift + Ctrl + M). Double click the trapezoid until its handles turn into rotation handles. Pick the midpoint of the trapezoid (with "+" sign). Drag it to the center of your circle. If you have activated the "snap from and to center of objects," it will show you a red-cross sign saying "Handle to center." Now, put your "+" sign on a place where it says "Handle to center." The "+" sign is your trapezoid's axis that is moved to the circle's axis. If the axis of your trapezoid is not moved to the circle's axis, when the trapezoid is rotated, it will rotate to itself. While if the axis is moved to the circle's axis, when the trapezoid is rotated, it will rotate to the circle.

6. Now, choose rotate menu in your Transform panel and type 15 in Angle box. Duplicate the trapezoid by pressing Ctrl + D and followed by pressing "Apply" in your Transform panel. Do it several times until your new trapezoids round the circle.

7. The next step is creating the inner circle. You can do this by pressing Ctrl + D on the previous circle to duplicate and then resize it. We can resize it by dragging in the top right handle and pressing Shift + Ctrl to make it keep on its proportional shape.
8. Color this second circle with black-to-white gradient by opening up Fill and Stroke panel (Shift + Ctrl + F), and then choose Fill - Linear Gradient followed by choosing Edit. In your Gradient Editor, you can choose the gradient color by pressing Add Stop button and slide the slider on each color box: R (Red), G (Green), B (Blue), and A (Alpha / Opacity).

9. Press F2 on your keyboard to activate Edit path by nodes function. With this tool, you can change the direction of your gradient.

10. Do the same steps as described in step 7 to step 9 to create 2 other circles so that the final result will be like this:

11. The final step is creating smaller circles as decoration. So, create a small circle (the size is up to you). Color it with white and no stroke, and put it close to the stroke of the second (big) circle.
12. Repeat step #5 and #6. Duplicate and rotate the small circle. Give 30 as new value in your Angle box in Transform panel, tab Rotation.
13. The final result will be similar to the picture below (the gradient may vary depending on the color and direction you choose).

PCLinuxOS Family Member Spotlight: pinoc
by pinoc as told to Smileeb

Q:How old are you?
A: I'm 50 years old.
Q: Married, single or what?
A: I'm married.
Q: Children, grandchildren?
A: I have 3 children, ranging from 21 to 9 years old.
Q: Retired or working and for how long and at what.
A: I work as scientific researcher/programmer in Germany, England, the US, and for the last 14 years in Italy for an international organization. My job is to do satellite image data analysis for a variety of purposes and develop custom software for specific needs, in particular pattern recognition in digital images. I work on a Mac and have about 30 virtual machines of different Linux/Windows operating systems to test the functionality of these tools.
Q: What is the area you live in like. Weather, Quietness, Scenery.
A: I live in the lake district in NW Italy. Although being one of the most densely populated areas in Europe, it is still very scenic, offering a wide range of outdoor activities. We get nice summers, and if you like a good winter experience, then the Swiss Alps are only one hour away.


Q: Are you handy with your hands and have any hobbies.
A: I like cooking and making cakes. It may sound weird, but I find ironing relaxing.
Q: What is your education level?
A: I have a Ph.D. in remote sensing/geosciences.
Q: Do you like to travel, go camping?
A: Yes, I enjoy visiting other countries and cities. Getting an insight in new cultures, languages, and living habits/conditions is very interesting and inspiring. Thanks to my job, I get the chance to go to conferences around the world.
Q: What caused you to try Linux and join this forum.
A: That was back in 1999 where you had to reboot MS-Windows 10 times per day to keep it working. A friend showed me his Red Hat system and I was well impressed with the stability, diversity of free applications, and the availability and full access to programming languages and debugging tools. After testing many other Linux distributions, I quickly became a die-hard KDE-fanboy and a loyal SuSE user for many years, until they made a big mistake in November 2006. A couple of distro tests later, I found my new home with PCLinuxOS because it had the best implementation of KDE. Then, my brother became interested in Linux, but needed a German system, so I started to look into the steps required to convert the English-only PCLinuxOS into a German-localised system, and summarised these steps in a script for ease of use. Once that worked, I did the same for my Italian friends, then looked at the systematic setup and found these steps could be applied also for another four languages; this became the first version of addlocale. About a year later, addlocale covered all other languages and desktop environments available in PCLinuxOS. Then I learned how to package and added some other scripts to facilitate using PCLinuxOS.
Tex's implementation of KDE, the fantastic teamwork with him and all other developers, and the desire to promote PCLinuxOS outside the English-speaking community via addlocale still are the key points for me contributing to this distro.
PCLinuxOS Family Member Spotlight is an exclusive, monthly column by smileeb, featuring PCLinuxOS forum members. This column will allow "the rest of us" to get to know our forum family members better, and will give those featured an opportunity to share their PCLinuxOS story with the rest of the world.
If you would like to be featured in PCLinuxOS Family Member Spotlight, please send a private message to smileeb in the PCLinuxOS forum expressing your interest.



Game Zone: Monochroma
by daiashi

About The Game
The story takes places in an alternate version of the 1950's where a huge company sells robots to the people in a fantastic city. You are playing the older of two brothers. On the night that your brother gets injured and you are seeking help, caught in a storm, you find yourself in a warehouse and discover an awful secret about that company.
Monochroma offers a deeply visual, intellectual and emotional experience. The game has a unique approach to storytelling without using any written or spoken words. Therefore, it requires the player to be actively involved to understand the narrative.
The story itself becomes part of the puzzle. Gameplay, visuals and the very limited color palette are used in an expressionist way to help tell the story. The player will find lots of references to other movies, books and games in the dystopian world of Monochroma. The challenge of the game is to make the player question his responsibilities as an individual and as a member of the system we're living in.
Deriving from the story, the gameplay consists of a boy who has to take care of his younger brother whose leg is injured in the beginning of the game. The younger brother is afraid of the dark, therefore the player can only put him down under the light to be able to jump higher and move faster. The player can't leave him behind, however, just as in real life.
Silent Narrative in an average 6 hours of playtime, told in 4 acts. It has realistic locations and puzzles that naturally blend with the environment, along with challenging puzzles without the arbitrary trial and error. It also features award winning visuals and an award winning soundtrack.
Monochroma visuals and gameplay is a lot like Limbo, in my opinion. I did enjoy the playthrough. However, some of the mechanics of the game can become annoying at times. I would recommend this game.
System requirements:
Fully updated PCLinuxOS and Steam
Hardware:
Minimum:
Recommended:
OS: PCLinuxOS
About The Company
Nowhere Studios is a game-design startup established in 2010 with the goal of bringing games made with passion and skill to players all around the world. They want to infuse the spirit so common in older games into those on the next-gen platforms to make the world's most respected games.
Some Gameplay Screenshots






Getting It To Run
Install Steam (if you don't have it installed already), then start it. You will need to create a new account, if you do not already have one. Once you have Steam up and running, go to the store tab. Click on the Linux tab, if you wish, and search for Monochroma. Click on and download the demo. If you have updated your system, including graphics drivers, you should be good to go.
http://store.steampowered.com/app/265830



Just Digging It With DIG

by Professor Tux J. Penguin
9 Commands to query DNS with DIG
Dig stands for (Domain Information Groper). It is a network administration command-line tool for querying Domain Name System (DNS) name servers. It is useful for verifying and troubleshooting DNS problems and also to perform DNS lookups and displays the answers that are returned from the name server that were queried. DIG is part of the BIND domain name server software suite. DIG command replaces older tools such as nslookup. DIG is available in all major Linux distributions.
1. Query Domain "A" Record
[youcantoo@localhost ~]$ dig yahoo.com
; <<>> DiG 9.9.3-P2 <<>> yahoo.com
;; global options: +cmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 43271
;; flags: qr rd ra; QUERY: 1, ANSWER: 3, AUTHORITY: 0, ADDITIONAL: 1
;; OPT PSEUDOSECTION:
; EDNS: version: 0, flags:; udp: 4096
;; QUESTION SECTION:
;yahoo.com. IN A
;; ANSWER SECTION:
yahoo.com. 1342 IN A 98.139.183.24
yahoo.com. 1342 IN A 206.190.36.45
yahoo.com. 1342 IN A 98.138.253.109
;; Query time: 27 msec
;; SERVER: 208.67.222.222#53(208.67.222.222)
;; WHEN: Mon Jun 16 15:20:59 PDT 2014
;; MSG SIZE rcvd: 86
The above command causes dig to look up the "A" record for the domain name yahoo.com. Dig command reads the /etc/resolv.conf file and querying the DNS servers listed there. The response from the DNS server is what dig displays.
Let us understand the output of the commands:
1. Lines beginning with ; are comments, and not part of the information.
2. The first line tell us the version of dig (9.8.2) command.
3. Next, dig shows the header of the response it received from the DNS server
4. Next comes the question section, which simply tells us the query, which in this case is a query for the "A" record of yahoo.com. The IN means this is an Internet lookup (in the Internet class).
5. The answer section tells us that yahoo.com has the IP address 98.139.183.24
6. Lastly there are some stats about the query. You can turn off these stats using the +nostats option.
2. Query Domain "A" Record with +short
By default dig is quite verbose. One way to cut down the output is to use the +short option. This will drastically cut the output, as shown below.
[youcantoo@localhost ~]$ dig yahoo.com +short
206.190.36.45
98.139.183.24
98.138.253.109
3. Querying MX record for Domain
Querying different types of DNS resource records only.
[youcantoo@localhost ~]$ dig yahoo.com MX
; <<>> DiG 9.9.3-P2 <<>> yahoo.com MX
;; global options: +cmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 58791
;; flags: qr rd ra; QUERY: 1, ANSWER: 3, AUTHORITY: 0, ADDITIONAL: 1
;; OPT PSEUDOSECTION:
; EDNS: version: 0, flags:; udp: 4096
;; QUESTION SECTION:
;yahoo.com. IN MX
;; ANSWER SECTION:
yahoo.com. 1080 IN MX 1 mta5.am0.yahoodns.net.
yahoo.com. 1080 IN MX 1 mta6.am0.yahoodns.net.
yahoo.com. 1080 IN MX 1 mta7.am0.yahoodns.net.
4. Querying SOA record for Domain
[youcantoo@localhost ~]$ dig yahoo.com soa
; <<>> DiG 9.9.3-P2 <<>> yahoo.com soa
;; global options: +cmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 49302
;; flags: qr rd ra; QUERY: 1, ANSWER: 1, AUTHORITY: 0, ADDITIONAL: 1
;; OPT PSEUDOSECTION:
; EDNS: version: 0, flags:; udp: 4096
;; QUESTION SECTION:
;yahoo.com. IN SOA
;; ANSWER SECTION:
yahoo.com. 595 IN SOA
ns1.yahoo.com. hostmaster.yahoo-inc.com. 2014061609 3600 300 1814400 600
5. Querying TTL record for Domain
[youcantoo@localhost ~]$ dig yahoo.com ttl
; <<>> DiG 9.9.3-P2 <<>> yahoo.com ttl
;; global options: +cmd
;; Got answer:
;; ->>HEADER<<- opcode: QUERY, status: NOERROR, id: 26925
;; flags: qr rd ra; QUERY: 1, ANSWER: 3, AUTHORITY: 0, ADDITIONAL: 1
;; OPT PSEUDOSECTION:
; EDNS: version: 0, flags:; udp: 4096
;; QUESTION SECTION:
;yahoo.com. IN A
;; ANSWER SECTION: yahoo.com. 1342 IN A 206.190.36.45
yahoo.com. 1342 IN A 98.139.183.24
yahoo.com. 1342 IN A 98.138.253.109
6. Querying only answer section
[youcantoo@localhost ~]$ dig yahoo.com +nocomments +noquestion +noauthority +noadditional +nostats
; <<>> DiG 9.9.3-P2 <<>> yahoo.com +nocomments +noquestion +noauthority +noadditional +nostats
;; global options: +cmd
yahoo.com. 1237 IN A 98.138.253.109
yahoo.com. 1237 IN A 206.190.36.45
yahoo.com. 1237 IN A 98.139.183.24
7. Querying ALL DNS record types
[youcantoo@localhost ~]$ dig yahoo.com ANY +noall +answer
; <<>> DiG 9.9.3-P2 <<>> yahoo.com ANY +noall +answer
;; global options: +cmd
yahoo.com. 1164 IN A 206.190.36.45
yahoo.com. 1164 IN A 98.139.183.24
yahoo.com. 1164 IN A 98.138.253.109
yahoo.com. 690 IN MX 1 mta5.am0.yahoodns.net.
yahoo.com. 690 IN MX 1 mta6.am0.yahoodns.net.
yahoo.com. 690 IN MX 1 mta7.am0.yahoodns.net.
yahoo.com. 172689 IN NS ns5.yahoo.com.
yahoo.com. 172689 IN NS ns1.yahoo.com.
yahoo.com. 172689 IN NS ns6.yahoo.com.
yahoo.com. 172689 IN NS ns2.yahoo.com.
yahoo.com. 172689 IN NS ns3.yahoo.com.
yahoo.com. 172689 IN NS ns4.yahoo.com.
yahoo.com. 558 IN SOA ns1.yahoo.com. hostmaster.yahoo-inc.com. 2014061609 3600 300 1814400 600
8. DNS Reverse Look-up
Querying DNS Reverse Lookup. Only display answer section with using +short.
[youcantoo@localhost ~]$ dig -x 98.139.183.24 +short
ir2.fp.vip.bf1.yahoo.com.
9. Querying Multiple DNS Records
Query multiple website’s DNS specific query viz. MX, NS etc. records.
[youcantoo@localhost ~]$ dig yahoo.com mx +noall +answer redhat.com ns +noall +answer
; <<>> DiG 9.9.3-P2 <<>> yahoo.com mx +noall +answer redhat.com ns +noall +answer ;; global options: +cmd
yahoo.com. 332 IN MX 1 mta7.am0.yahoodns.net.
yahoo.com. 332 IN MX 1 mta5.am0.yahoodns.net.
yahoo.com. 332 IN MX 1 mta6.am0.yahoodns.net.
redhat.com. 467 IN NS ns4.redhat.com.
redhat.com. 467 IN NS ns2.redhat.com.
redhat.com. 467 IN NS ns3.redhat.com.
redhat.com. 467 IN NS ns1.redhat.com.
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Don't Install Pipelight, It Helps Infect the Web With DRM and Microsoft
by Dr. Roy Schestowitz
Reprinted from techrights.org
under Creative Commons license.
Nasty DRM pipeline

Summary: Putting DRM on GNU/Linux, and especially DRM that Microsoft controls, is a very bad idea
Microsoft tried to break the Web with Silverlight, turning the Web into a bunch of binaries or cryptic blobs that will be run by proprietary software on the user's computer/client's end (probably not spiders, except for Microsoft's). It is worse than Flash and more like DRM, which Silverlight was used to promote. When Silverlight died, its key proponent Netflix had to go infect HTML. This is even worse because it means that the Web itself starts requiring proprietary blobs. One site said this is "Good news for folks tired of installing Microsoft Silverlight just so they can stream videos from Netflix: The company now has an HTML5 media player which works without any plugins.
"Here's the bad news (for now): While Netflix is rolling out its HTML5 player to another platform, you still have to jump through some hoops to install Silverlight if you want to watch Netflix on a computer running GNU/Linux."
Well, this is about DRM in HTML, which is even worse and has put Mozilla to shame. Mozilla also got a little close to Mono, which does not invite much support.
Now, using the Mono-based Moonlight one could almost get this DRM going, but it helped Microsoft get a foothold on the Web. One project remains which still tries to achieve this. It received coverage in some FOSS sites, which is unfortunate. One site said: "Pipelight is a wrapper for Windows NPAPI plugins such as Silverlight, Widevine or Flash (the Windows version) which allows you to use these plugins in native Linux web browsers and thus, use services that aren't officially supported on Linux, such as Netflix (Silverlight), HBO Go (Widevine) and so on."
Another bit of coverage said:
| Pipelight is the interesting open-source project to support Windows browser plug-ins within native Linux browsers. Pipelight serves as a wrapper for Windows plug-ins in Linux browsers using Wine and for browsers supporting NPAPI plugins. This software, which allows Silverlight and Netflix to work on Linux, is out with a big update. -- http://www.phoronix.com/scan.php?page=news_item&px=MTcxMDE |
This is about DRM and it should be rejected or worked around by breaking DRM, not by bringing DRM to GNU and Linux.
The fight here is not just against Microsoft but against DRM. What Pipeline does helps create the perception that GNU/Linux is now compatible with DRM. Some copyright maximalists can use that to impose DRM everywhere. A Slackware-oriented site, writing about a similar issue, noted that support is lacking, so it really is only the illusion of compatibility.
| The version 35 of Chromium has a major side effect that many people are not going to like. The support for browser plugins that use Mozilla's NPAPI protocol to communicate with the browser has been removed and only Google's own PPAPI protocol is supported as of now (MS Windows users still have a bit of time before the same happens to their Chrome browser -- removal of NPAPI support in Windows is scheduled for the end of 2014). This step was of course announced long time ago and many reminders were posted, but if you need Java support in your browser, or want to watch Netflix using Pipelight, then you are out of luck. PPAPI versions for these browser plugins do not exist and in the case of Pipelight, are very hard to create. -- http://alien.slackbook.org/blog/new-pipelight-release-accompanied-by-wine-pipelight-and-what-about-chromium/ |
Anything that requires running a blob for access to data/information should be rejected, especially on the Web. We are entering a dangerous era where FOSS become fundamentally incompatible with data. Unless of course we fight back...
Inkscape Tutorial: Create a Candle
by Meemaw
Some of us like to make wallpapers for the holidays. I saw a tutorial about creating a candle, and I thought it would be a great project to do before the holiday season starts, so we might use it in one of our wallpapers. Opening Inkscape, use whatever size page you want. The default is A4, Portrait oriented, so I'll probably open Document Properties from the File menu, and change it to Letter, Landscape oriented. The choice is up to you.
To draw the basic candle, you can use the pen tool, or you can create a rectangle and an ellipse and choose Path > Union to combine them. If you do that you will have to create extra nodes across the top and pull them out to make the part of the candle that is melted down. It's just a decision between making the separate items, merging them and pulling nodes ... or drawing the whole thing by hand with the pen tool.


Let's fill it with color. Open your fill and stroke window, and fill your object with your desired color. Mine will be an orange shade. Set the stroke to None. I'm going to add a linear gradient in the center to look like a highlight.
Using the Pen tool, draw an irregular elliptical shape. This will be the top of the candle. Fill the shape with a radial gradient, lighter in the center. When the candle is lit, the center is the brightest, so make it very close to white.

Let's highlight the top so it looks more like the wax has melted down and fallen over. At the top-front, draw an elongated irregular ellipse shape, just below the edge. Blur it, then apply a white to transparent radial gradient. Do several around the edges.

Let's add a highlight to help define the shape of the lip. We will add one highlight going all the way around. Draw a ring, and then draw an inner ring on top of it. Select both rings and choose Path > Difference. Set it to a semi-transparent white and Blur it.

Now we want to show the inside of the candle as brighter because it is lit, so we'll add a highlight on the inside of the lip. Draw a shape that looks as if it curves around the back of the candle. Slide it under the inside ellipse that we drew first, then blur the inner highlight.

Apply a radial gradient going from a bit lighter than your candle to transparent. Extend the gradient handles beyond the bounds of the object. So far, mine looks like this:

I'm sure you can see other edits I have made in my progress.... changing the color of the center to a little darker one, and shortening the amount that the wax has dripped. Most of that is personal preference, so you draw yours however you wish.
Now we can work on the flame. Every lit candle has a pool of wax at the bottom of the wick, so let's do that first. Draw an ellipse in the top-center, color it yellow-orange, and give it some blur. Draw the wick. You can start with a black rectangle, but flare the edges a bit to make it look uneven. Change the fill to a black to yellow gradient, top to bottom.

The flame will take a bit of work. Start off drawing a sort of ellipse with a dent in the bottom (looks kind of like a fingernail to me). Make the fill a solid, fleshy color (left). Draw a little different shape on top of it, leaving the bottom of the first shape visible. Fill the top shape with white and blur it (center). Draw a flat arrowhead-like shape at the bottom of the flame. Fill it with yellow and blur it. Draw a circle at the bottom of the flame and blur it. Apply a peach to transparent gradient, running top to bottom (right). Select all parts and group them.

Place it on top of your wick. Now, mine looks like this:

I did a couple of things to mine after this. I am going to put a dark background behind my candle. However, many of the gradients I have been using have been transparent in places. I'm sure there is a professional way to keep the background from showing through, but the easiest way I have found is to duplicate the candle base, change the fill to solid white or something close, and send it to the bottom of the drawing. I also added tiny a bit of shade on the front of my candle to simulate a shadow from the wax that is dripping over the front.
Now we will add a background. Draw a rectangle on your page and send it to the bottom of the drawing. Mine will be a dark blue to transparent linear gradient, top to bottom. I made it mostly dark blue with the transparent showing only toward the bottom. Then I added a shadow at the bottom of the candle. Since it's your drawing, you can do as much or as little of this as you desire. Mine now looks like this:

You can always dress up your candle by designing a base or platter to put it on, or putting some sort of floral design around the bottom. I remember ms_meme making a candle like this and drawing poinsettia leaves around the bottom for a Christmas wallpaper.
It's your project -- do what you want, and personalize your creation!
Programming With Gtkdialog: Part Four
by Peter Kelly (critter)
Comments
In the previous article, I stated that comments are not normally allowed in the XML part of the gtkdialog code, but may be included with a little trickery. The most effective way that I have found is that outlined in the excellent series of articles in the Puppy Linux forum by member zigbert.
First off, you have to choose a character sequence that will not naturally appear in the code to mark the start of the comment. The bash shell uses the hash '#' character for comments, but gtkdialog often includes color codes in hexadecimal notation that begin with a hash mark. To overcome this, zigbert advocates using a double hash '##' and I have adopted the same practice, but you may choose what you will as long as it is unambiguous to the process.
Colors are often specified in hexadecimal format and may need to be preceded by a hash mark '#'. The hexadecimal system counts in sixteens just as we normally count in tens (decimal). To represent the sixteen values the digits 0-9 and the letters A-F (or a-f) are utilized. Modern digital computers, due to the way that they operate, are more efficient when presented with numbers referenced in binary (twos), octal (eights) or hexadecimal. A color is defined by giving a value for each of its Red, Green and Blue components or channels. Using two hexadecimal digits gives 256 possible values for each color or a total of 65536 possible color variations when the three values are combined. The value '00' gives that color channel zero intensity while half and full intensity are represented by '88' and 'FF' respectively. Pure blue is then represented by the hexadecimal value #0000FF while #FC8207 would produce an orange color. Most computer calculators are able to convert values between the different counting systems. |
With the comments so marked, it is a simple matter to filter them out before trying to execute the code. To do this, we pass the text stored in the MY_DIALOG variable (or whatever you called it) to a simple sed statement which removes the comments and then stores the "comment-less" output in a new variable ready for use as usual. You don't need to understand the use of sed to use this procedure. You can just include the one line as in the following example. For the curious, sed substitutes (that's the first s in the code) any text that begins with ## followed by any number of any characters (.*) with whatever appears between the final two forward slashes (//). In this case, there is nothing, which has the desired effect of deleting that text. Comments always appear on a line of their own or at the end of a line of code and so the code gets through unaltered.

For the simple example above, comments are unnecessary, but in more complex code, they can help in debugging, modification and maintenance.
Using the colorbutton and spinbutton widgets with signals
The colorbutton widget is used to display a useful color selection dialog with optional tool tips and an eyedropper tool to allow you to choose a color from anywhere on the screen. The selected color is then displayed on the face of the button and the color value returned in a variable.

The default appearance of the colorbutton widget is rather uninteresting, as you can see in the picture below.

We can improve on this by using a powerful feature of gtkdialog known as signals, which were demonstrated briefly in the second article. If we turn off the visibility of the colorbutton widget, it can still be active but will not appear on the dialog. This means that we can place another button or control on the dialog, and use a signal from that widget to operate the default function of the colorbutton, which is to display the color selection dialog.
In the next example, I shall use one of the many functions of the wonderful and powerful ImageMagick toolkit, which is available in the PCLinuxOS repositories.

The ImageMagick logo is a picture of a wizard casting a spell as shown here. I want to make the wizard more Eco-friendly by changing the color of his cap and gown from blue to green.
ImageMagick includes a function called mogrify which allows us to change all sorts of things in an image, such as transparency and, the one we are interested in here, fill color. Looking closely at the image we can see that there are in fact many different blueish shades and hues and none of them are a real pure blue.
If we try to change only pure blue pixels then mogrify will dutifully change all pixels of pure blue to the new color leaving all others unaffected. The mogrify function accepts as an option a value of from 0 to 100 to specify the fuzziness of the selection. Lower values are more pedantic and demand a closer match while higher values are more easy-going matching values that are 'a bit, sort of like this'.
As we don't know what fuzz value to specify, we need a way of changing the value within its upper and lower limits. For this task I have decided to use the spinbutton widget. The final dialog contains, within its various hboxes and vboxes, a pixmap widget, a hidden colorbutton widget, a decorative button to send a signal to the colorbutton widget, a spinbutton widget, a button widget to undo the changes, some text labels and an OK button to accept the changes and save a copy of the image with the wizards new robes.

This is the code:



We start by making copies of the original file to work with and initialize the fuzziness value. The colorbutton is set up to have visibility off, a title is added and the chosen value will be stored in variable CB_1. The default value is a color from the wizard's robe somewhere in the middle, but this will be changed when we set a new color. The alpha attributes are not actually used here, but it does no harm to include them. The action that will take place when the color selection dialog is closed is to execute the mogrify function with a fuzziness value taken from the spinbutton setting, the new fill color will be the one we just selected and the color to be replaced is #0000ff - pure blue. The output will be to one of the copies we made.
The first button widget is the one that will send the signal to activate the invisible colorbutton. When this button is pressed, a button-press-event signal is raised and we tell gtkdialog to action the activation of colorbutton widget CB_1 upon receipt of this signal.
The spinbutton range and step values are set in the tag attributes. A default starting value of 50 seems to be a good value to set here. The leave-notify-event signal is raised whenever the mouse pointer leaves the widget, and the action that takes place here is to save the current value of the spinbutton into the file declared in the output file tag pair.
The revert button simply copies the unchanged copy we made over the changed copy so that we may try again. The final OK button exits the script leaving the file im-changed.png as our result.
Before leaving, the script the temporary files are removed.
The results:

Fuzziness too low

Fuzziness too high

The final image
The hscale and vscale widgets
I'm going to stick with ImageMagick for the next example, this time using the mogrify command with the resize and rotate options. The majority of the code is similar to previous examples and I have included comments to document the actions, but the two scale widgets introduce some new features. An item provides a marker along the scale and can incorporate three types of data. The value along the scale at which the mark should appear, its position relative to the scale and optionally any text to appear with the mark. Each of these is separated by a vertical bar character.
The mark position has a value of 0, 1, 2 or 3 to represent left, right, top and bottom. The text to accompany the mark may include pango markup tags to format the text. https://developer.gnome.org/pango/stable/PangoMarkupFormat.html I have used this feature to highlight the minimum value of 10 on the vertical slider which controls the scaling of the image. Normally, a value of zero would be expected here but that would make no sense for this feature. White-space between the span tags is important and is used here to position the text.
This is the code:





I have added a black border to the image to demonstrate the effects of the transformations. When the image is rotated, you will notice four white triangles around the image, and the little girl will appear to have changed in size relative to the image. These four triangles are added to the image increasing the overall dimensions of the image but the size of the little girl remains the same, unless you have also applied a scaling effect.



Handy Utilities To Organize Your Life, Part Four
by Meemaw
We've looked at sticky notes, note pads, to-do lists, notebooks and address books. Now let's look at some Combination Programs that include some or all of the above.
KDE BasKet
If you use KDE programs, BasKet is a good program. It's nice, much larger and more integrated than many of the other sticky/note/reminder apps. It's possible to integrate it into Kontact so that everything is all together.
When you open BasKet for the first time, you will see this screen, along with some example notes.

In the tree at left, the Welcome section with Ex: pages and Tips are present in the new install. I suggest leaving them until you are more familiar with the program. The Tips note is fairly extensive, so you might leave that even longer. Also, the BasKet website has a good tour of the program.

For a new note, click in the tree where you want it (General, maybe) and click the New button in the toolbar. The resulting window will ask you to name it, decide the format of the note and indicate its location in the tree (just in case you clicked in the wrong place).

After opening it, you can add whatever you want. In one of the examples, it shows the addition of photos, clipart and even web links in addition to written notes. In the image below, I added several sections to a note named Magazine. That note is pretty self-explanatory (article ideas in several categories).

In this image, I tried adding a few different things (clipart and to-do reminders). The arrow shows that clicked on the note and dragged it to another location. This is good if you are trying to organize your thoughts into a report. You can type your points into separate text boxes, and then drag them around until they are in the order you want.

When your mouse passes over one of the notes, a blue bar will show on the left and right sides. The left bar will allow you to drag the note around in the window. Also with the left bar is an arrow which, when clicked, allows you to tag your note (below). The right bar allows you to widen your note. It will lengthen as you add to the note.

KDE-PIM - from kde.org: Kontact is the integrated solution to your personal information management (PIM) needs. It combines well-known KDE applications like KMail, KOrganizer and KAddressBook into a single interface to provide easy access to mail, scheduling, address book and other PIM functionality.

Starting Kontact the first time, you see a Summary page which has a sidebar on the left side (above). Depending on what you installed, the sidebar items include Summary, Mail, Contacts, Calendar, To-Do List, Feeds, Journal, Notebooks, Time Tracker and Pop-up Notes. You can choose to enable or disable any of those in Settings > Configure Kontact.

You can also choose to start Kontact with the Summary or one of the other categories in your sidebar. I choose to see my calendar page when Kontact opens.

Each feature in Kontact is highly configurable. You can choose to view your weekly agenda (shown above on the right side of the window), a calendar of the month, or even a daily timeline or list of appointments. The column between the sidebar on the left and the main agenda can include a two (or more) month calendar, a to-do list with details viewer plus a calendar manager. You can choose to show as much of this or as little as you want, simply by selecting or deselecting it in the View menu.
You can add contacts one at a time, or import your contacts from another source (vCard, csv file, LDIF,file, GMX file or LDAP server). Clicking on New Contact gives you the following window where you can enter loads of information.

You can export your contacts to five formats (csv, LDIF, GMX and two vCard formats). You can export your calendar as well. It is exportable as an HTML file, an iCalendar and a vCalendar.
You can configure your email to run through Kontact using KMail. I haven't ever done that, but if you use KMail, you probably already know how to configure it.
The handy thing is that if you started using KNotes or KJots when I did those summaries, they are integrated into Kontact, and the notes you started are already there.
The great thing about this program is that everything is in one place, and you don't have to open several windows and switch back and forth. Simply click your desired task in the sidebar and do your work.
Osmo - from Sourceforge: Osmo is a handy personal organizer, which includes calendar, tasks manager, address book and notes modules. It was designed to be a small, easy to use and good looking PIM tool to help to manage personal information.
Opening Osmo shows you a calendar page with four tabs: Calendar, Tasks, Contacts and Notes. The tabs can be displayed on any side of the main window. I moved ahead a month to add a few things. The bolded numbers with the apostrophe in front of them are reminders I have entered (my grandson's birthday is the 21st), while the grey dot on the 14th denotes a task I entered in the task tab.

If you double-click on a date, the bottom pane will show what notes and tasks are there. If you are studying the calendar, you can click the arrow next to "Previous and next month" in the middle of the window and see a three month spread.

You can print a calendar or a task list from Osmo.

Osmo is fairly straightforward to use, adding notes and reminders and dating them for the correct day. The notes tab is easily used as well. On the Contacts tab, click on New Contact and the entry window will open to add your contact's information.

You can also import your contacts. Your contacts should be in a .csv file. when you choose Import. Choose your file, then you will be presented with a window which requires you to match the fields in your list (right side) with the fields in Osmo.

When you get your contacts imported, you will have a list. You can assign a group to each for better sorting, but if you don't already have them in groups in your list, you will have to put each one in separately using Edit Contact (the second icon from the left). When you click on one contact, the information is displayed in the lower pane. The only things that display in the contacts tab are Group, First Name and Last Name. You can opt to only display First and Last names.

Notes can also be added to Osmo in the Notes tab. You will be asked to give a name for your note. Then double-click on the note, and a window will open for you to enter the text. Save it and close the window. You can add as many notes as you wish.
Maybe you have found a program or two that are useful. Different people use different methods to get organized, so I hope you have found a favorite among these options.
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